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FT-301C: STRATEGIC MANAGEMENT

Level of Knowledge:Working knowledge.

Course Objectives:

» The aim of this subject is to impart an understagdo the student of MBA-
3rd semester of the concept of Strategic Manageriéat course also seeks
to prepare the student in analytical and decisiaking skills whereby
he/she can analyze real business problems in thedbcase studies and take
decisions accordingly.

Evaluation:

The course will have a weightage of 100 marks wWihmarks from internal assessment
and 60 marks from External assessment. The Intagsassment will include marking on
presentations, case studies, assignments, attendaddnternal tests. The external main
exam will consist of two sections—Section A wilsteahe conceptual knowledge of the
student and will be of 30 marks; Section B shait the student’s analytical and decision
making skills by presenting one or two case studied0 marks.

Course Contents:
Unit 1: An Overview of Strategic Management:

» Understanding Strategy

» Defining and Explaining Strategy

* Levels at which Strategy operates

» Strategic Decision-making

» Schools of Thought on Strategy Formulation
» The Process of Strategic Management

Unit 2: Strategic Intent:
* Vision
* Mission
» Defining Business
* Goals and Objectives

Unit 3: The General Environment:

* General Environment
* Analyzing the Environment
» Diagnosis of Environment

* Environment Appraisal:
» Concept of Environment,
» Environment Sector & Scanning



» Organizational Appraisal:
» Dynamics of Internal Environment
» Methods & Techniques used for Organizational Agaki



Unit 4: Corporate Level Strategies:

Grand Strategies

Stability Strategies

Expansion Strategies—Diversification
Mergers

Takeovers

Joint Ventures

Strategic Alliances

Retrenchment Strategies
Combination Strategies

Unit 5: Business Level Strategies

Business level Strategies
Generic business,
Tactics for Business strategies.

Unit 6: Strategic Analysis and Choice

The process of Strategic Choice
Corporate level Strategic Analysis:

» Corporate Portfolio Analysis- BCG Matrix
» GE matrix

» Hofer's Product/Market Evolution Matrix
» Directional Policy Matrix

Business Level Strategic Analysis-Experience Cémalysis:
Life Cycle Analysis

Industry analysis

Porter’s Five Forces Model of Industry Attractivese
Strategic group analysis

Competitor analysis

Coming to a Strategic decision.

YVVVYYYVY

Unit 7: Strategy Implementation:

» Activating Strategies:

> Interrelationship between Formulation & Implemeiotat
» Project & Procedural Implementation
» Resource Allocation

Structural Implementation:
» Structures for Strategies
» Organization Design & Change

Behavioral Implementation:
» Leadership Implementation



» Corporate Culture, Politics
» Personal Values, Social Responsibility & Businedsds

* Functional & Operational Implementation:
» Functional Strategies
» Functional, Financial, Marketing, Operational & &aral Plans
» Functional, Financial, Marketing, Operational & &aral Policies
» Operational Implementation

Unit 8: Strategic Evaluation & Control:

» An overview of Strategic Evaluation and Control
» Strategic & Operational Control
» Techniques of Strategic Evaluation & Control

Text Readings:

1. Azhar Kazmi, Business Policy and Strategic Managemeﬁ'ifi Ed., Tata-
McGraw Hill

2. Lawrence R. Jauch, Rajiv Gupta and William F. Gkj&usiness Policy and
Strategic Management™ Ed., Frank Bros and Co.,

3. Thompson and Stricklandtrategic Management-Concepts and Cadé¥
Ed. Tata McGraw Hill.



FT-302C: PROJECT MANAGEMENT

Level of Knowledge Expert Knowledge

Course Objectives

* To acquaint students with project management meémabito develop skills
on project planning, analysis implementation anakrd.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination, carrying 60 marks wdlvk two Sections, A and B. Section
A, worth 24 marks, will consist of four theory qtieas out of which a student will be
required to answer any two. Section B, worth 36 knamwill have five practical/

Numerical problem(s)/ or cases, out of which a etwdvill be required to attempt any
three. Each question will carry equal marks. A ¢joesnay have one or more sub-parts.

Course Contents:

Unit 1: Project Planning and Phases:

* Need and importance
» Phases of capital budgeting
* Project analysis facts

* Resource allocation framework:
> Investment strategies
» Portfolio planning tools
> Interface between strategic planning and capitdbgkting

» Generation and Screening of Project Ideas.

Unit-2: Project analysis:
* Market and demand analysis (Including demand ftetg)
» Technical Analysis and Financial Analysis:

» Cost of Project
» Working capital requirement & its financing.

Unit-3: Project Selection:

* Project cash flows

* Time value of money
» Cost of capital

* Appraisal criteria



Analysis of Risk.

Unit-4: Project Management and Control:

Project Organizations
Planning and Control of project
Human aspects of project management

Project control tools:
» Gantt Charts
» Line off Balance

Unit-5: Network techniques for Project Management:

Basic concepts of networks

line estimation and determination of critical path:
» PERT models

» CPM models

Network cost systems and activity crashing
Resource leveling.

Unit-6: Project Review: Need for reviews:

Initial review

Performance evaluation

Abandonment analysis,

Evaluating the capital budgeting systems.

Text Reading:

1. Prasanna Chandra. “Project Planning, Analysis, cBele Implementation

and Review”, New Delhi, Tata McGraw Hill Publicatis 2007.

2. Vasant Desai “Project Management” Mumbai, Himal&ublishing House,

2007.

3. R.Panneerselvam and P.Senthilkumar “Project Manag&mlew Delhi, PHI

Learning Private Ltd.,2009.

Suggested Reading:

1. N.P.Agrawal and B.K. Mishra “Project Management”vN®elhi, Ramesh

Book Depot, 2008.

2. Bhaveh M Patel “Project Management” New Delhi, \élaublishing house

Pvt. Ltd.2000.






FT 303 CA- SUMMER TRAINING PROJECT

Level of Knowledge Expert Knowledge

Course Objectives:

 The Summer Training Project aims to widen the gsttideprospective by
providing an exposure to real life organizationak&vironmental situations.
It is positioned between first and second yeath@iend of second semester).

Duration: 30 - 45 Days

Scheme of Examination:

After completing SIP the student gives the predemtaand viva voce as part of
evaluation.

Internal Examination Process:

1. Submission of Report
2. Presentation
3. Viva -Voce



FT303 CB: MAJOR RESEARCH PROJECT PHASE | (SYNOPSIS,DATA

COLLECTION)

Level of Knowledge Expert Knowledge

Course Objectives:

To help the students to understand the Conceplietidods of Business
Research.

To familiarize the students and give them exposui@yoiopsis design,

objectives formulations and methodology to be Usedata analysis.

To guide the students in questionnaire design andgythe exposure of data
collection

To provide the knowledge to the students so thet will be able to plan,
design

and execute research proposals

To familiarize the students with the various methotfidata analysis and
prepare the research reports.

Scheme of Examination:

Total Marks: 100
Internal Marks: 50
External Marks: 50

Activities and Marks Distribution:

In the third semester, each student will be alledaguide in their respective
specialization. Students will finalize the topic BfRP with the guide and prepare
synopsis in the standard format prescribed byrthtute/concerned faculty time to time

General format of the synopsis should be:

Cover page containing the research topic, namasgiitlite with logo, Name
of Guide and Student.

Introduction/Conceptual Framework

Review of Literature

Objectives

Methodology (Universe, Sample, hypothesis (if am@search design (if
any)Tools for data collection and analysis)

Expected Outcomes

References in APA Style

Internal Marks (50):

Synopsis submission to coordinator duly approve&hbige (10 Marks) to be
awarded by the faculty/coordinator



» Presentation of Synopsis (10 Marks) to be awargeal i|anel consisting of an
expert and/or coordinator and Guide

* Presentation of Questionnaire (10 Marks) to be dadby a panel consisting
of an expert and/or coordinator and Guide

» Submission of collected data and synopsis in Sforah (10 Marks) to be
awarded by Guide

» Evaluation of data (10 marks) by Guide

External Marks (50):

There will be external evaluation by the externahrainer and internal
examiner appointed by the Principal.



FT-304 M PRODUCT & BRAND MANAGEMENT

Level of Knowledge Working Knowledge

Course Objectives

* To help student understand the concepts of PraflecBrand, various tools
and models used for challenges faced by today'sages.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

External examination will have 9 questions out diick a student has to attempt five. In
the external examination, there will be two sedidnand B. Section A, worth 24 marks,
will consist of four theory questions out of whialstudent will be required to answer any
two. Section B, worth 36 marks, will have five graal/ Numerical problem(s), out of
which a student will be required to attempt anye#éirEach question will carry equal
marks. A question may have one or more sub-parts.

Unit 1: Introduction to Product:

* Product focused organization

* Market focused organization

* Buyer Behavior Models

* The Adaptation & Diffusion of new product developrhe
» Seven stages of PLC

* Managerial Application of PLC

Unit 2: New Product Development:

* New Product Development Models

* New Product Development Process
* New Product Strategy

» Screening New Product Ideas

» Business Analysis & Product Testing

Unit 3: Product Management:

» Commercialization(Test Marketing & Launching Nevoéuct)
» Resistance to change

* Leveraging new product growth

* Maturity : Its Nature & Causes

* Extending PLC

Unit 4: Product Elimination:



* The Importance, Reasons & Scope of Product Deletion
» |dentification & Evaluation of Deletion Products
* Implementing the Deletion Decision



Unit 5: Introduction to Brand:

* Brand

* Brand Reflection

* Commodities Vs brands

* Brand Name

» Developing appropriate Brand Strategies

» Hofstele Model for understanding Core Value of Bran
» Brand Significance

Unit 6: Brand Equity:

» Criteria of choosing Brand Elements

» Concept & Principle of Brand equity

* Communication Mix Strategy

* Measuring & Interpretation Brand Performance

Unit 7: Various Terms associated with Brand:

» Brand Positioning

* Brand Personality

* Brand Loyalty

* Brand Image

* Brand Building

* Brand Extension

* Brand Image

* Brand Valuation

» Strategic Brand Management & Global Branding

Text Reading:

1. Product Strategy and Management — Michael BakesaisWHart, Pearson
Education Publication

2. Product management - Donal R. Lehmann, Russel &eMiiata Macgraw
Hill

3. Brand Management: Y L R Murthy Vikas Publication

4. Strategic Brand Management - Kevin Lane Keller

5. Brand Management: S A Chunawalla

Suggested Reading:

1. Brand Management: U C Mathur Macmillan

2. Brand Management: S L Gupta Himalaya Publishingddou

3. Brand Positioning Strategies for Competitive Adeayet -Subrato Sen Gupta
4. Brand Management: Ajay Kumar



FT 305 M CONSUMER BEHAVIOUR

Level of Knowledge:Working Knowledge

Course Objective:
 To familiarize the students with the Basic Concepfs Supply Chain
Management
* To Make the students understand the Role of ITuipp8 Chain Management

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsct®m A will carry 36 Marks
Comprising 5 Theory questions out of which a studeill be required to attempt any
three questions. Section B will carry 24 Marks cosipg of one or more Case(s).A
guestion can have one or more sub-parts.

Course Contents:
Unit 1: Introduction to Consumer Behavior:

» Definition, Nature, Scope, Orientation in the stuafyConsumer behavior &
Applications

* Understanding Product, Consumers, Market Strategl Segmentation &
Product Positioning

Unit 2: Environmental Influences on Consumer behaor:

* Culture, Sub Culture, Cross cultural understandjngocial Class and
consumer behavior, Significance of Family in consurbehavior, Personal
Influence and Diffusion of Innovations ,Life stylsarketing ,Personal
influence and the opinion Leadership Process

Unit 3: Consumer as an Individual:

» Consumer Needs & Motivation, Consumer Personalitg &elf Concept ,
Consumer Perception

* Nature of Consumer attitude, Changing attitude,SDarer attitude formation
and change, The process of learning Consumer b@havi

Unit 4: Consumer Decision Process:

* Pre-Purchase Process: Information processing(Coot€mpnsumer Research
,Importance ,Process & Design)

» Post Purchase Process : Consumer Decision rulesquther Buying Process,
Stages, Participants ,Industrial/Organizationalibgypehavior)



» Post purchase Process : Framework, Dissonancéagtts/ Dissatisfaction

Unit 5: Consumer Behavior models:

* Nicosia model

* Howard Sheth Model

» Engel-Blackwell and Miniard Model

» Sheth Family and decision making Model

Unit 6: CRM:

 CRM and Consumer Behavior, Consumer Roles markeé\&a CRM
» Communication, Advertising & Consumer behavior
» Consumerism &public Policy issues

Books Recommended:

1. David L. Loudan and Albert J. Della BiitaConsumer BehaviolNew York,
McGraw Hill, 4" Edition 1993

2. Leon G. Schiffman and Leslie lazar Kanukonsumer BehavigrLondon,
Prentice Hall, 8" Edition 1995.

3. Dr. S.L. Gupta and Sumitra Pal ,An Indian PerspectConsumer Behavior,
Text & Cases

4. Satish K Batra and S H H Kazmi, Consumer Behavibext & Cases

Suggested Readings:

1. William L. Wilkie, Consumetbehavior New York, John Wiley and Sons®3
Edition, 1994.

2. Dish Sheth, Banwari Mittal and Bruce I. Newman, &amer behavior and
Beyond, 1999.



FT-306 M ADVERTISING & SALES PROMOTION

Level of Knowledge Working Knowledge

Course Objectives

* To help student understand the concepts of AdvegtisSales, Sales
Promotion & various tools and models used for @maes faced by today’s
managers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

External examination will have 9 questions out diich a student has to attempt five. In
the external examination, there will be two sedidnand B. Section A, worth 24 marks,
will consist of four theory questions out of whialstudent will be required to answer any
two. Section B, worth 36 marks, will have five preal/ Numerical problem(s), out of
which a student will be required to attempt anyeéirEach question will carry equal
marks. A question may have one or more sub-parts.

Unit 1: Advertising — An Introduction :

» Origin and Development,

* Marketing Mix & Advertising,

» PLC & Advertising, Indian Advertising,

* Functions & Benefits of Advertising,

» Advertiser’'s Role in Organising for Advertising,
» Advertising Agency,

* Agency Structures,

» Agency Compensation & Evaluation.

Unit 2: Copy Decisions

* Visualization of Ad Layout,

* Preparation of Layout | & II,

» Advertising Copy for Print Media,

» Copywriting for Radio,

* TV & Outdoor Media,

» Styles and Stages in advertising copy creation yG&pe-) Testing methods
and measurements.

Unit 3: Branding Environment:

* Segmentation & Positioning,
» Brand Awareness & Brand Attitudes & Feelings,



* Brand Image,
* Equity & Personality,
» Advertising Objectives & Budget Allocation

Unit 4: Media Planning & Strategy:

* Types of media,

* Identifying the Target Market,

» Establishing Media Objectives,

» Develop & Implementing Media Strategies.

* Media Evaluation:

Television,

Buying TV Time,

Audience Measures, Radio,
Newspapers,

Newspaper Advertising & Types,
Purchasing, Circulation & Readership,
Purchasing Space.

YVVVYVVVY

* Planning Advertising Campaign

Unit 5: Introduction to Sales Promotion:

» Definitions-Sales Promotion,

* Promotion Mix,

* Factor Influencing Sales Promotion Growth

* Advantages & Drawbacks of Sales Promotion,
* Promotion of Sales Force.

Unit 6: Sales Planning & Promotion:

* How Sales Promotion Affects Sales,

» Sales Promotion Objectives & Budget Allocation,
» Sales Promotion Design Issues,

* Planning Guidelines & Evaluation

Unit 7: Sales Promotion-Tools & Techniques

* Types of Sales Promotion,

» Sales Promotion Tools & Technique,
* Price Deals,

* Price-Packs,

* Refunds & Rebates,

* Coupons,

» Contests & Sweepstakes,



Product Sampling,
Trade Coupons,
Exchange or Buyback Offers

Text Reading:

1. S HH Kazmi & Satish K Batra: Advertising & SalesoRotion
2. Foundations of Advertising S A Chunawalla K C $eth
3. Aaker, Batra & Myers: ADVERTISING MANAGEMENT; Preice Hall

India.

Suggested Reading:

1.
2.

Wright, Winter & Zeigler: ADVERTISING; Tata McGrawill.
Wells, Burnett &Moriarty: ADVERTISING PRINCIPLES AN
PRACTICES, Prentice-Hall

Sandage,Fryburger&Rotzoll:ADVERTISING;Irwin.

J. T Russel & Ronald Lane: KLEPPNER'S ADVERTISING®CEDURE;
Prentice Hall.

Don E. Schultzz STRATEGIC ADVERTISING CAMPAIGNS; NT
Business Books.



FT304F- BUSINESS TAXATION

Level of Knowledge:Expert knowledge

Course Objectives:

» To Lay a Conceptual Framework for Business Taxation

» To develop an ability in the student to apply tkdical concepts with
Practical life problems

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

Section A: 24 Marks Comprising Three Theory questions out of Wwhacstudent will
be required to attempt any Two Questions.

Section B: 36 Marks Comprising Four Practical Problems out ofakihé student will
be required to attempt any Three questions.

Course Contents:
Applicable Assessment Year 2010-11, Previous Yead@-10.

Unit 1: Basic Concepts and framework of Income taAct, 1961.:
* Framework

» Definitions under Income Tax Act ,1961
Assessment Year

Previous Year

Income

Person

Assessee

YVVYVYYVY

* Residential Status and Incidence of Tax

Unit 2: Income under the ‘head Income from Salaries

* Basis Of Charge
* Meaning

* Terms Taxable as Salary:
» Advance Salary
» Leave Encashment/Salary
» Bonus
» Gratuity
» Pension



» Taxability of Allowances U/s 10(14) and Rule 2BB:
House Rent Allowance U/s 10(13A)

Traveling allowance

Conveyance Allowance

Daily, Helper, Uniform allowance

Children education allowance (Rule 2BB)
Transport allowance(Rule 2BB)

YVVVYVYVY

—

axability of perquisites:

Concept of Specified and Non specified employee

Valuation of Rent-free unfurnished and furnishedomemodation
Leave Travel Concession

Free Education

Lunch/refreshments

YVVYVYY

* Permissible deduction:
> Entertainment Allowance
» Professional Tax

» Simple problems based on the computation of Incivora Salaries

Unit 3: Income under the head ‘income from House poperty:
* Basis of Charge

» Concept of House property:
» Concepts of Municipal Valuation, Fair Rent, Staridamt
» Determination of Gross and Net Annual value

» Deductions u/s 24:
» Standard deduction
> Interest on Borrowed capital

* Special Cases:
» One House property Partly Let out and Partly Setfupied
» More than One House, Deemed to be let out

» Simple problems based on the computation of Incfvora house property

Unit 4: Income under the head ‘Profit and gains obusiness and professions:

* Basis Of charge
» Basic concepts and principles

» Specific allowances:

Rent, Rates , Taxes, Repairs, Insurance for bgjldia 30
Repairs and insurance of Machinery plant and furaiti/s 31
Depreciation u/s 32 and concept of block of Assets
Expenditure on scientific research u/s 35

Amortization of Preliminary expenses u/s 35D

Interest on borrowed capital 36(1)(iii)

YVVVYY



>
>

Bad Debts u/s 36(1)(vii)
Conditions under Section 37(1)

Specific disallowances:

>
>

Income tax , Wealth Tax, Security Transaction Tax
disallowances in respect of expenditure exceedisig2R,000 U/s 40A(3)
and exception in Rule 6DD

Special Provisions of Section 44AD,44AE,44AF
Maintenance of Books of accounts U/s 44AA
Tax Audit U/s 44AB

Unit 5: Income under the Head ‘Income from CapitalGains:

Basis Of Charge

Concepts:

YVVVVVY

Capital Assets

Short term and Long Term Capital Assets
Cost of Acquisition and Improvement
Indexation

Transfer

Full Value of Consideration

Simple problem based on Computation of Capitahggiincluding Shares)

Deduction:

>
>

>
>

Capital gain arising from the transfer of residahtiouse property u/s 54,
Capital gain arising from the transfer of land duder agricultural
purposes u/s 54B ,

Capital gain not to be charged on investmentsitacebonds 54EC ,
Capital gain arising from the transfer of a longrtecapital asset other
than a house property u/s 54F

Unit 6: Income under the head ‘Income from Other Saorces:

Basis of Charge
Concepts and Few examples of Income from othercesur

Taxability of :

>
>
>

Income from Lottery, Horse race Puzzles and candega
Interest on securities
Simple concepts relating to dividend and dividersdribution Tax

Unit 7: Permissible Deductions under Chapter VIA:

Deductions relating to:

>
>
>
>

Section 80C relating to various investments

Section 80CCC Pension fund

Section 80D in respect of medical insurance premium
Section 80DD relating to dependent being a perstndisability



» Section 80DDB relating to medical treatment
» Section 80E in respect of repayment of Educatiam lo

Unit 8: Return of Income and TDS:

» Basic concepts relating to filing of return:
» Filing of return U/s 139(1)
» Concepts relating to PAN u/s 139A
» Tax return preparers Scheme 139B

 Tax Deducted at Source:

TDS provisions relating to Salary u/s 192
Interest on securities u/s 193

Interest , other than Interest on securities ufsA19
Payment to Contractors U/s 194C

Rent U/s 194-I

YVVVVY

Text Readings:

1. Student guide to Income Tax Dr. V.K Singhania Driida Singhania,
Taxman publications
2. Income Tax S.C., Saklecha, Satish Publication House
Suggested Readings:

Direct Taxes ,T.N Manoharan, Snow White Publicaion



FT305F: FINANCIAL ENGINEERING

Level of Knowledge:Expert knowledge

Course Objectives:

* To Lay a Conceptual Framework for Financial Engiimege

* To develop an ability in the student to apply tkdical concepts with
Practical life problems

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

Section A: 24 Marks Comprising Three Theory questions out of Wwhacstudent will
be required to attempt any Two Questions.

Section B: 36 Marks Comprising Four Practical Problems out ofakihé student will
be required to attempt any Three questions.

Course Contents:
Unit 1: Introduction to Derivatives:
» Concept and terminology of derivatives

» Types of derivatives:
» Future
» Forward
» Options
» Swaps

» Concept of Participants:
» Hedgers
» Speculators
> Arbitragers

» Use of Derivatives
* Types of Order

Unit 2: Futures Contract:

» Concepts relating to futures
» Difference between futures and forward Contracts
» Concept of Margin, Clearing house, Hedging

» Types of futures:
» Stock Index futures
> Interest rate futures



» Foreign exchange and currency futures etc.

» Simple problems based on valuation of futures

Unit 3: Option Contracts:
» Concept and Meaning of Options

* Types of Options:
» Call Option
» Put Option

* Various trading Strategies Involving Bull and Bear

» Preparation of Pay-Off table/schedule from theapof view of:
> Holder
> Writer

» Valuation of Options using:
> Black-Schole model

» Concepts of Delta Theta Gamma Vega

» Exchange Traded Options:
» Stock Option
» Foreign currency options

Unit 4: Swaps:

* Introduction and meaning of Swaps
* Mechanics of Swaps transactions

* Interest rate Swap

» Currency rate swaps

Text Readings:

1. John C Hull, Options, Futures and Other Derivativdew Delhi Pearson
Education Asia publication.

2. Derivatives, SSS Kumar, Prentice Hall Pvt Ltd.

3. N D Vohra, B R Bagri, Tata McGraw Hill Publication

Suggested Readings:

Derivatives, Robert A Strong, Thomson Publications



FT-306F WORKING CAPITAL MANAGEMENT

Level of Knowledge:Expert Knowledge

Course Objectives:

* To Lay a Conceptual Framework for Working Capitardgement
» To develop an ability in the student to apply tkdical concepts with

Practical life problems
Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

Section A: 24 Marks Comprising Three Theory questions out of Wwhacstudent will
be required to attempt any Two Questions.

Section B: 36 Marks Comprising Four Practical Problems out ofakihé student will
be required to attempt any three questions.

Course Contents:

Unit 1: Basic Concepts and overview of Working capal:

» Concept and definition of working capital

* Need of working capital

» Components of Working capital

* Meaning of Operating cycle, Current Assets and €uriabilities

Unit 2: Computation of Working Capital:

» Simple problems relating to computation of workaagpital using
» Operating Cycle method

» Current assets and Current liabilities Method using
o Normal Problems
0 Cash Cost Method

* Mini Cases based on Working Capital

Unit 3: Cash Management:

* Introduction and basic concepts
» Objectives of Cash Management

* Measurement of Cash using:
» Baumol Model
> Miller-Orr Model



» Preparation of Cash Budget
* Concept of Cash Management Techniques
* Mini Cases based on Cash Management

Unit 4: Inventory Management:

» Basic Concepts
» Trade-off Between cost and benefit associated litél of Inventory

» Techniques for managing Inventory and problemsdase
» EOQ Model
» ABC Analysis
> Pareto Analysis

* Inventory Management using the following Methodd aroblems based on:
» Firstin first out (FIFO)
» Last in first out(LIFO)
» Weighted average
> Base Stock Method

» Computation of Stock out Costs and problems basestack out
* Mini Cases based on Inventory Management

Unit 5: Receivable Management:

» Basic Concept

» Category of Cost Related to receivables
» Concept of Credit Policy and Bad debts
» Concept of Factoring

* Problems based on:
» Effect of change in Credit Policy
» Using Factoring

* Mini Cases based on Receivable Management

Unit 6: Working Capital Financing:
* Trade

* Bank Credit:
» Cash Credit/Over draft
» Bill purchase/discounted
» Terms loans
» Letter of Credit
» Hypothecation, Pledge ,Mortgage, charge

e Commercial Paper
» Certificate of Deposit



» Factoring
* Mini Cases based on Working Capital Financing

Text Readings:

1. 1 M Pandey, Vikas Publication House Pvt. Ltd.
2. Prasanna Chandra, Tata McGraw-Hill Publishing Canggad.

Suggested Readings:

M Y Khan and P K Jain, Text and Problems and Cdsta McGraw-Hill
Publishing Company Ltd.
FT-304 H: INDUSTRIAL RELATIONS AND LABOUR LAWS

Level of Knowledge:Working Knowledge

Course Objective:

* To expose the student to the multidimensional cemipés of industrial
relations to enable him to develop the right perSpe of this delicate
responsibility to deal with union constructively.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsctitm A will carry 36 marks
Comprising 5 Theory questions out of which a stadeil be required to attempt any
threequestions. Section B will carry 24 Marks comprisofgne or more Case(s).

A question can have one or more sub-parts.

Course Contents:
Unit 1: Industrial Relations in India:

* Overview
» Approaches to Industrial Relations
* Industrial Disputes Act, 1947

Unit 2: Workers Participation in Management:

* Meaning

» Objectives

» Essential Conditions

* Forms

* Reasons for Limited Success and Suggestions farolement
« WPM in India



Unit 3: Collective Bargaining:

* Meaning
* Functions
e Process

* Importance of Collective Bargaining to Employer @&ployees

Unit 4: Trade Union:

* Meaning
* Functions
* Problems

* Trade Union Movement in India
« Trade Union Act, 1926

Unit 5: Factories Act, 1948

Unit 6: E.S.I.C Act, 1948.

Unit 7: Payment of Gratuity Act, 1972

Unit 8: Contract Labour (Regulation and Abolition) Act, 1970

Text Readings:

1. R.C. Chawla and K.C. Garg, Industrial Law, LudhiaKalyani Publichers,
1993.

2. N.D. Kapoor, Handbook of Industrial Law, Sultan @& Sons, New Delhi.

Suggested Reading:
1. J.K. Bareja, Industrial Law, New Delhi, Galgotialdishing Co., 2001.






FT 305 H: HUMAN RESOURCE AND ORGANISTIONAL DEVELOPM ENT

Level of Knowledge: In-depth Knowledge

Course Objective:

* To help the students develop an understanding eintfed and methods of
HRD & importance of Organization Development. Theurse is also
intended to give insights in the design, developnaewl delivery of HRD &
OD Programmes.

Scheme of Examination:

Total Marks :100
Internal Marks : 40
External Marks: 60

The External Examination will have Two Sectionsctigsm A will carry 36 marks
Comprising 5 Theory questions out of which a stadeil be required to attempt any
threequestions. Section B will carry 24 Marks comprisofgne or more Case(s).

A question can have one or more sub-parts.

Course Contents:
Unit 1: Basics of HRD:

« Definition
* Characteristics
» Historical Perspective

Unit 2: Employees’ Acquisition and Development:

» Training and Development Needs

* Methods and Measuring its Effectiveness
» Career Planning & Development

» Performance Appraisals and Methods

» Coaching, Mentoring.

Unit 3: Behavioral Tools:

* FIRO-B
» Johari Window
» Transactional Analysis

Unit 4: Organization Development

e Introduction
+ Definition
* History



* Assumptions
* Values and Beliefs in Organization Development (@BJ Transformation.

Unit 5: Theory and Management of OD:

* Foundations of OD
e OD Process
* Action Research and OD

Unit 6: OD Interventions:

* Overview

* Types

» Team Interventions, Inter-Group Interventions, Caoghpnsive and
Structural Interventions

» Choosing the Depth of Organizational Intervention.

Text Readings:

1. VSP Rao, Human Resorce Management, 2nd EditiorglBublications, A,
45, Naraina, Phase-I, New Delhi

David S. Decenzo and Stephen P. Robbins, Persdfnelan Resource
Management, New Delhi, Prentice Hall, 3rd edition.

Wendell L. French and Cecil N. Bell Jr., OrganiaatDevelopment,

New Delhi, Prentice Hall, 5th Edition, 1999.

abrown

Suggested Readings:

1. Arun Monappa and Mirza S. Saiyadain, Personnel idament, New Delhi,
Tata Mcgraw hill, 1995.

2. Don Harvey and Donald R. BrownAn Experiential Approach to
Organizational Development,New Jersey, Prentice Hall Inc., 1996






FT-306 H: COMPENSATION AND REWARD MANAGEMENT

Level of Knowledge:Working Knowledge

Course Objective:

* To Familiarize students with the dynamics of wagd aalary administration
and current trends in India.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsctige A will carry 36 marks
Comprising 5 Theory questions out of which a stadeil be required to attempt any
threequestions. Section B will carry 24 Marks comprisofgne or more Case(s).

A question can have one or more sub-parts.

Course Contents:
Unit 1: Wage and Salary Administration:

» Definition

» Goals/Objectives

* Job Evaluation

* Wage and Salary Surveys

* Time and Piece Rate

» Merit Pay/ Skill Based Pay

» Factors Affecting Wage Concept of Pay of Perforneanc

Unit 2: Incentives Plans:

* Individual and Group Incentive Plans

* Productivity Gain Sharing Plans

» Profit Sharing Plans.

» Non Financial and Financial Incentives

Unit 3: Employee Benefits:

* Supplemented Pay Benefits( Pay for time not worked)
* Insurance Benefits

* Retirement Benefits

» Employees Service Benefits

e ESOPs

* Flexible Benefits



Unit 4: Governing Laws:

* Provident Fund Act 1952

e Minimum Wages Act, 1948

» Payment of Wages Act, 1948
* Payment of Bonus Act, 1965

Unit 5: Current Trends in Compensation and Reward Management:

Text Readings:

1. Garry Dessler, Personnel/ Human Resource Managein@mion, Prentice
Hall, 1994

2. VSP Rao, Human Resorce Managemefif, Edition, Excel Publications,
A,45Naraina, Phase-1 ,New Delhi

3. David S. Decenzo and Stephen P. Robbins, Persokhatian Resource
Management, New Delhi, Prentice Half &dition.

Suggested Reading:

1. William B. Werther Jr. and Keith Davis, Human Res®u & Personnel
Management, Singapore, McGraw Hill! Edition. 1993






FT 304 I: OBJECT ORIENTED PROGRAMMING USING C++

Level of Knowledge:Working Knowledge

Course Objective:

Object Orientation is a new approach to understaedcomplexities of the
real world. In contrast to the earlier approachks procedural etc, object
orientation helps to formulate the problems in dtdseway giving high

reliability, adaptability and extensibility to ttaplications. This course offers
the Modern Programming Language C++ that shall tbbp students to
implement the various concept of Object Orientapoactically. The students

will be able to program in the Object Oriented Trealogy with the usage of
C++.

Scheme of Examination:

Total Marks: 100

Internal Marks: 20
Practical Marks 20
External Marks: 60

There will be an internal assessment of 20 markiseaaiernal examination of 60 marks.
External examinations will have 8 questions outvbich a student has to attempt any
five questions. Each question will carry equal rsark

Course Content:
Unit 1: Object Oriented Programming:

* Introduction
* Procedure Oriented Programming Vs. Object OrieRiegjramming (OOP)

* Overview:

Objects

Classes

Encapsulation

Data Binding

Inheritance and Polymorphism
Dynamic Binding

Message Passing.

YVVVVYVYVY

Unit 2: Review of constructs of C used in C++:
+ Variables

» Type Declarations:
» User defined Data Types
» Increment and Decrement Operators
» Relational and Logical Operators



» If then else clause
» Conditional Expressions

* Input and Output statement:

Loops

Switch Case

Arrays

Structure

Unions

Automatic

External and Static Data Members and Member Fumctio

YVVVYVYVVY

» Pointers, Preprocessor Directives

Unit 3: Arrays & Pointers:

* Arrays of Objects

» Pointer to Object

» this Pointer

* Function:

General form
Prototypes
Returning
Passing Objects to Functions Returning Objects
Friend Function
Recursion
References.

YVVVVYVYVY

Unit 4: Inheritance:

» Multilevel and Multiple Inheritance

* Constructor

» Destructor and Inheritance

* Private

* Public and Protected Access Specifies
* Function and Operator Overloading.

Unit 5: Templates:

* Virtual Function

* Pure Virtual Function

* Polymorphism

* Generic Functions

* Generic types

* Overloading of Templates and Functions

» Standard parameters with Template Functions
» Applying Generic Functions

* Generic Class



» File and Exception Handling
» Introduction to Templates and Exception Handling
> File Classes
» Opening and Closing a file
» Reading and writing a Text File
» Detecting EOF

Text Readings:

1. E. Balagurusamy,“Object Oriented Programming with C++”, Tata
McGraw Hill Pub. Co. Ltd., New Delhi, 2000

2. Robert Lafore,"Object Oriented Programming in Turbo C++” , Galgotia
Pub. Pvt. Ltd., New Delhi, 2000

Suggested Readings:

1. Herbert Schildt, “C++ : The Complete Reference”,taTacGraw Hill
Publishing Company Ltd., New Delhi, 1999

2. D. Ravichandran, “Programming with C++”, Tata Mc@®rHill Pub. Co. Ltd.,
New Delhi, 2000



FT- 305 | COMPUTER NETWORKS

Level of Knowledge:Expert Knowledge

Course Objective:

* The objective of this course is to help studentariderstand the concepts of
Data Communication and Computer Networks and relssues and their use
in organization and processing complex businessnmdtion.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

Course Contents:

Unit 1: Computer Networks:

e Introduction

* Distributed Systems

* Network Goals & its Applications
* Protocol Hierarchies,

* Network Architecture

» Design Issues for the Layers:
» Simplex
» Half-duplex
> Full-duplex

* Interfaces and Services:
» Connection Oriented
» Connection less Services
> Service Primitives.

Unit 2: Reference Models

* The OSI Reference Model
» The TCP/IP Reference Model
» Comparison and Critiquef the OSI and TCP/IP Reference Models.

Unit 3: Physical Layer:

» Concepts of Data Transmission
* Transmission media

* Guided and Unguided Media

» Digital and Analog Transmission
* Transmission Impairments



» Multiplexing:
> TDM
> WDM
> FDM



» Switching Techniques:
» Circuit
» Packet and Message
» Cellular Radio
» Wireless Transmission
» Modems
> DSL
» Cable Modem

 |ISDN

> Introduction
» |ISDN Channels

» |ISDN Layers

» Services

» Communication Satellites.

Unit 4: Data Link Layer:

* Framing, Error Control

* Flow Control

» Unrestricted Simplex

» Simplex Stop-and-Wait Protocol

» Sliding Window Protocols:
» HDLC
> SLIP
> PPP

* Network Layer:
» Internal Organization
» Routing
» Congestion
>

Routing:

Shortest Path

Multipath

Congestion Control Algorithm
Preallocation of Buffers

Choke Packets

o Deadlocks and Services of Network Layer.

O O O0OO0oO0o

* Transport Layer:

» Services of Transport Layer,
» Transport Protocols
» Connection Management.

Unit 5: Upper OSI layers:



Session Layer and Transport Interaction

Presentation Layer:

» Translation

» Authentication

» Data Compression

Application layers:

» Message Handling System(MHS)
» File transfer

» Access and Management (FTAM)

Transmission Technology:
» Broadcast Networks

» Point-to-Point Networks
LAN

MAN & WAN Topologies
Wireless Networks
Internetworking

o Introduction to Bridges

O O oo

Routers
Switches
Gateways
Repeaters

Y VVVY

Introduction Functioning and Services:
o Novell Netware

0 Window NT

0 NOS (Network Operating Systems)

Text Reading:

1.
2.
3.

Andrew. S. Tannanbaum, “Computer Networks”, Praatilall 2006.
Behrouz A. Forouzan, “Data Communication and Neking”, Tata
McGraw Hill Pub. Co. Ltd., New Delhi, 2006.

Suggested Readings:

1.

2.

Martin, J.,“Computer Networks and Distributed Processing’, Prentice-
Hall, 1985.

Tom Sheldon;Encyclopedia of Networking”, Tata McGraw Hill Pub. Co.
Ltd., New Delhi, 1998.

William Stallings, “Data and Computer Communication”, Prentice Hall
India, New Delhi, 2001.

William A. Shay,“Understanding Data Communications and Networks’,
Vikas Publishing House, New Delhi, 2001.

Parag Diwan and Dharam Bir SingtComputer Networks Driven e-
Commerce Technologies”Excel Publisher Pvt. Ltd., New Delhi, 2000.



6. S. KeshaviAn Engineering Approach to Computer Networking”,
Addision- Wesley Longman (Singapore) Pte. Liew Delhi, 2001.

7. D.E.Comer, “Data and Network Communication” Delnfdomson Learning
Singapur  2000.

FT-306 | SOFTWARE ENGINEERING

Level of Knowledge Expert Knowledge

Course Objective:

* The objective of this course is to help studentsitderstand the basics of
Software Engineering, Project Management, Softw@tality and related
issues and their use in organization and processmgplex business
information.

Scheme of Examination:

Total Marks : 100
Internal Marks : 40
External Marks : 60

Course Contents:

Unit 1: The Product and the Process

* The Evolving Role of Software

» Software Characteristics A layered Technology
* Process

* Methods and Tools

* The Software Process

» Software Process Models

* Linear Sequential Model

* Prototyping Model

* RAD Model

* The Incremental Model

* The Spiral Model

» The Concurrent Development Model
» The Component-Based Development
* The Formal Methods Model

* Fourth Generation Techniques.

Unit 2: Projects Management Concepts, Software Prass and Project Metrics



* The Management Spectrum:
» The People
» The Product, The Process

* The Project Measures, Metrics, and Indicators

* Metrics in the Process and Project Domains

» Software Measurement

» Reconciling Different Metrics Approaches

» Metrics for Software Quality

* Integrating Metrics within the Software Engineerfgcess.

* Project Scheduling and Tracing:

Basic Concepts

The Relationship Between People and Effort
Defining a Task Set for the Software Project
Selecting Software Engineering Tasks
Refinement of Major Tasks

Defining a Task Network, Scheduling
Earned Value Analysis

Error Tracking

The Project Plan.

YVVVVYVYVYVYYYVY

Unit 3: Software Project Planning, Risk Analysis ad Management:

* Observations for Estimation
» Project Planning Objectives
» Software Scope, Resources
» Software Project Estimation
» Decomposition Techniques

» Empirical Estimation Models
* The Make/Buy Decision

* Automated Estimation Tools

» Reactive versus Proactive Risk Strategies:
Software Risks

Risk Identification

Risk Projection

Risk Refinement

Risk Mitigation, Monitoring, and Management,
Safety Risks and Hazards.

YVVVYYVY

Unit 4: Software Quality Assurance:

* Quality concepts, the quality movement

» Software quality assurance, software reviews
* Formal technical reviews

» Formal approaches to SQA

» Statistical software quality assurance



Software reliability, mistake-proofing for software
The ISO 9000 quality standards
SQA Plan

Software Testing Techniques & Strategies:

Objectives white box testing methods

Black box testing

Testing for specialized environments

Architectures

Applications

A strategic approach to software testing, stratesgices
Unit Testing, Integration Testing

Validation Testing

System Testing and the Art of Debugging.

YVVVVVVYVYYY

Unit 5: Analysis & Design Concepts and Principles:

Mechanics of structured analysis

Data flow design and Entity Relationship design
Overview of Object Oriented Design Concepts
Design Concepts and principles

Effective modular design

Data modeling.

Client/Server Software Engineering, Re-engineering:
The Structure of Client/Server Systems

Software Engineering for Client/Server systems
Analysis modeling issues

Design for Client/Server systems and testing issues
Software Maintenance Software Re-engineering
Software reengineering process model

Reverse engineering

everse engineering user interfaces restructuring:
Code restructuring
Data restructuring
Forward engineering
Economics of reengineering
Introduction to CASE.

VVVVVA VVVVVVYY

Text Readings:

1.

2.

Roger S. PressmafSoftware Engineering”, 6" Ed., Mc Graw Hill Inc.,
New York, 2005.

Pankaj Jaloté Software Engineering Narosa Publishing Hous8®2Edition
1999

lan Sommerville “Software Engineering Pearson Education "7Edition
2006.



Suggested Readings:

1.

Martin L. Shooman;Software Engineering”, McGraw Hill International
Book

company, New Delhi, 1985

Richard E.Fairely;Software Engineering Concepts’; Mc Graw Hill Inc.
New York, 1997

G. Meyers,“The Art of Software Testing”, Willey-Inter-Science, 1979.
Bruce I. Blum,“Software Engineering- A Holistic View”, Oxford
University Press, New York, 1992

uramah Finzi, Software Testing in Real World', Addison-Wesley, New
Delhi, 2000

Barbara ktchenhamSoftware Metrics” , Blackwell, UK, 1996



FT-304 P: PRODUCTION PLANNING AND CONTROL

Level of Knowledge Expert Knowledge

Course Objectives

* The course is design to equip the students withctireepts of Production
Planning and Control (PPC). The emphasis will betlom application of
concepts and tools used in PPC for achieving eficy and quality
superiority.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination, carrying 60 marks walk two Sections, A and B. Section
A, worth 36 marks, will have five theory questionst of which students will be required
to attempt three questions. Section B, worth 24ksjawill have one or more practical/
Numerical problem/ case(s). A question may haveasmaore sub-parts.

Course Contents:
Unit-1: Introduction to Production Planning and Control:

* Production Management Technologies
» Evaluation

« PPC

« PLC

» Appropriate Technology

» Decision in Production systems

* Planning Horizon Type decision

* Market Driven System:
» Wheel and Hub
» World Class Manufacturing
» Lean Production

» Agile manufacturing and lean v/s Agile Need of PPC
* Functions of PPC

» Factors Influencing PPC in the Organization

* Manufacturing Methods

* Managerial Policies

* Pre-requisites of PPC.

Unit-2: Materials Planning and Control:

* Input Required for Materials Planning and Control



» Steps in Materials Planning and Control

» Techniques of Materials Planning and Control

* Machining Allowances, Make or Buy Decision

» Scientific Stock Control Techniques (Inventory GohiModels).

Unit-3: Factors Influencing Process Planning:

» Step in Process Planning
* Process Selection
* Tools control.

Unit-4: Manufacturing resource planning (MRP II):

* Introduction

* Aggregate production planning

» Master production scheduling

* MRP Il (Introduction, concepts)

* MRP Il with Just in Time

» Choice of software

» Making MRP Il system work

» Achieving business objectives with MRP

Unit-5: Scheduling:

» Factors Influencing Scheduling
* Working and Scheduling Charts

* Job Sequences:
» njob on two machines
» njob on three machines

* Project Scheduling
» Critical Ratio Schedulin
» Assignment Techniques (Assignment - Model).

Unit-6: Capacity Planning:

» Capacity Planning

* Integrated Production Planning and Control
* Push system

* Pull system

» Bottleneck

» Hybrid Push-Pull system.

Text Reading:



1. Jhamb L. C. “Production Planning and Control”, PulBeerest Publications,
2001.

2. Hari Raghu Rama Sharma, “Production Planning andtrGoConcepts and
Application”,

3. New Delhi: Deep and Deep Publications, 2000.

Suggested Reading:

1. Bill Scott, “Manufacturing Planning System”, London McGraw-Hill
Publications, 1995.

2. George W. Plossl, O. R. Licky's. “Materials Requiment Planning”, New
York:

3. McGraw-Hill Publications, 1994.



FT-305 P BUSINESS PROCESS REENGINEERING

Level of Knowledge Expert Knowledge

Course Objectives

* To help student understand the concepts of BusiRessess Reengineering,
various tools and models used for problems facechéyagers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination, carrying 60 marks walk two Sections, A and B. Section
A, worth 36 marks, will have five theory questionst of which students will be required
to attempt three questions. Section B, worth 24kmawill have one or more case(s). A
guestion may have one or more sub-parts.

Course Contents:

Unit-1: Introduction to BPR:

e What is BPR

* Philosophy of BPR

* Fundamental tenets of BPR
» Benefits & pitfalls of BPR

* Drivers to BPR.

Unit-2: Process reengineering framework:

* Opportunity assessment

* Planning the process re-engineering project.
Unit-3: Organizing for process reengineering:

* Process Focused organization

» Organization process reengineering team
Unit-4: Process analysis and design:

* Process analysis

* Process design.
Unit-5: Planning and implementing the transition:

* Planning the transition
* Implementing the transition
» Tracking and measuring process performance



* Success factors of BPR
» Managing barriers to BPR success

Unit-6: Tools and techniques used in BPR:

» Case tools

»  Work flow systems

* Imaging technology

* Floware

* Business design facility tools
» Change management tools.

Unit-7: Risk and impact measurement:
* Role of IT in BPR

Suggested Reading:

1. Lon Roberts, “Process Re-engineering: The Key thiddng Breakthrough
Success”, New Delhi: Tata McGraw Hill, 1992.

2. Henry J. Johnson, Palrik Mchine, A.John Pandilepwifliam A Wheater,
“Business Process Reengineering: Breakpoint Siestdégr Market
Dominance”, Chichester, John Wiley & Sons, 1993.



FT-306 P: TOTAL QUALITY MANAGEMENT

Level of Knowledge Expert Knowledge

Course Objectives

* To help student understand the concepts of TotaliQuManagement, and
Research of various tools and models used for pnabfaced by managers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination, carrying 60 marks wadlk two Sections, A and B. Section
A, worth 36 marks, will have five theory questionst of which students will be required
to attempt three questions. Section B, worth 24ksjawill have one or more practical/
Numerical problem/ case(s). A question may havearmeore sub-parts.

Course Contents:
Unit 1: Core Concepts of Total Quality Management:

» Customer focus
* Quality for profits right first time
» Cost of quality

Unit 2: TQM Organization:

e Structure

* Mangers role Models

* Recognition & awards

* Quality delivery process

» Pitfalls in Operationalising TQM and methods of ialag them

Unit 3: Learning from quality gurus:

» Edward Deming

* Joseph M. Juran

* Karon Ishikawa

* Philip B. Crosby

» William E. Conway and their applications in todaigsiness Environment

Unit 4: Bench marking:

« Definition
* Reason to benchmark
* What to benchmark



BM process
Pitfalls& criticism of BM
Appraisal of TQM and improvement program

Unit 5: Tools and techniques of TQM

Techniques for analyzing a quality process
Quality Circles

Statistical process control

Failure Mode & Effect analysis

Computer aided inspection

Data collection & analysis

Six sigma and control chart

Unit: 6: Quality Award and certifications :

ISO-14000:

» Concepts

» Certifications

» methods and implementations

ISO-9000:
» Concepts
» Certifications
» Methods and implementations Malcolm Bal ridge Qyakward
» Methods and implementations Rajiv Gandhi Qualityahev

Text Reading:

1.

2.

3.

Sharma D.D Total Quality Management: Principles Practices &cass”
New Delhi, sultan chand & sons, 2004.

Sunraraju S.M. Total Quality Management: a premier” New Delhi, Tata
McGraw -Hill Publication,1999

Besterfield Dale H. Total Quality Management” New Delhi Pearsons
Education,2004.

Suggested Reading:

1.

2.

J. M. Juran and Frank M. Gryna Ed3ufan’s Quality Control Handbook”,

New York: McGraw-Hill Publications, 2001.

Tapan P. Bagchi,ISO 9000: Concepts, Methods and Implementation”,

Allahabad: Wheeler Publishing.

Kit Sadgrove, Making TQM Work” , New Delhi: Kogan Page India P. Ltd.,
2000.

Eugene L. Grant and Richards, LeavenworBtatistical Quality Control” .

New York: McGraw-Hill Publications, 2000.






